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Abstract 

 

Map production, also called cartography, is one of the processes of visual representation of reality. This 

practice has for a long time been of huge interest to humanity and was initially a handcraft[2]. Today 

most maps are produced with the help of computers and are often the last step of a GIS analysis – the 

way the result is presented. This makes knowledge of map production important and relevant when 

working with different GIS analysis. 

There are several GIS programs on the market, both free and commercial software. ArcGIS is one of the 

most common programs used by companies when producing maps and is often used in universities for 

teaching. However, there are other programs on the market. Two examples of these are QGIS and 

MapInfo. QGIS is free open source software and MapInfo is licensed software like ArcGIS. The objectives 

of this thesis are to explore and learn the steps of map production in these programs and to look at how 

interchangeable the programs are in map editing. This is examined by trying to create the same map and 

map series in the three programs. From the process and result an evaluation schema is created to 

present the functionality as well as a discussion to raise the pros and cons of the programs. 

The result of creating a simple map shows that it is possible to create the same map in all three 

programs, except from some minor differences. When looking at the evaluations schema it is clear that 

the programs have almost the same functionality. The biggest difference is that both ArcGIS and QGIS 

have a tool for generating an atlas while MapInfo lacks this functionality.  What the evaluation schema 

does not show is the differences in how user-friendly the programs are. This is further narrated in the 

discussion part of the report where the pros and cons are reported. The conclusion is that ArcGIS and 

QGIS are much alike when it comes to producing maps while MapInfo works differently and are harder 

to get used to.  

The result gives a good indication of which programs to choose and what type of functionality that exists, 

though a more profound study could have been done where more types of maps were created for more 

reliable results.  
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Sammanfattning 
 

Att producera kartor, även kallat kartografi, är en process för att visuellt representera verkligheten. 

Denna lära har sedan länge vart ett stort intresse för männskligheten och var under en längre tid ett 

hantverk[2]. Idag är de flesta kartor producerade med hjälp av datorer och är ofta det sista steget i en 

GIS analys – nämligen sättet att presentera sitt resultat. Detta gör kunskapen om kartproduktion viktig 

och relevant när man arbetar med olika GIS analyser. 

Det finns ett flertal GIS program på marknaden, både gratis och licenserade programvaror. ArcGIS är en 

av de mest använda programmen bland företag när man ska producera kartor och är ofta det program 

som används inom GIS-utbilding. Dock finns det andra program på marknaden. Två exempel på detta är 

QGIS och MapInfo. QGIS är en gratis programvara medan MapInfo är en licenserad programvara precis 

som ArcGIS. Syftet med den här studien är att utforska och lära sig kartproduktionsdelen av programmen 

och att jämföra funktionaliteten i kartredigering. Detta görs genom att försöka skapa samma karta och 

kartserie i de tre programmen. Utifrån denna process och resultatet skapas en utvärderingsmatris för att 

presentera funtionaliteten och därefter hålls en diskussion kring för och nackdelar med programmen. 

Resultatet från framtagandet av den enkla kartan visar att det är möjligt att skapa samma karta i alla tre 

programmen, med undantag från några små skillnader. När man kollar på utvärderingsmatrisen är det 

tydligt att programmen mer eller mindre har samma funktioner. Den största skillnaden är att både 

ArcGIS och QGIS har ett verktyg för att generera en atlas medan MapInfo saknar denna funktion. Vad 

utvärderingsmatrisen inte visar är skillnaderna i hur användarvänliga programmen är. Detta redogörs i 

diskussionsdelen av rapporten där för och nackdelarna tas upp. Slutsatsen är att ArcGIS och QGIS är 

mycket lika när det kommer till att producera kartor medan MapInfo fungerar annorlunda och är svårare 

att bli van med. 

Resultatet är en god indikation på vilket program man kan välja och vilka funtioner som finns även om 

man kunde ha  gjort en mer djupgående undersökning för mer tillförlitliga resultat.   
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1 Introduction 

1.1 Background 
As a GIS engineer it is not uncommon to be faced with the task of producing maps that are both 

customer-friendly and good looking. ArcGIS, delivered by ESRI, is at many times the standard GIS 

program used by agencies and companies when producing maps and is also the most commonly used 

program for teaching GIS[1]. However, there are other GIS programs on the market that can be used for 

producing maps. Two examples of these are QGIS and MapInfo. QGIS is a free and open source 

geographic information system which provides data viewing, editing and analysis capabilities while 

MapInfo, like ArcGIS, is a non-free mapping and analysis application for desktops.  

The focus and evaluation of this study will solely be on ArcGIS, QGIS and MapInfo. These programs are 

frequently used by Sweco and since this project is carried out together with Sweco, the study is set after 

their requirements and their interest in how interchangeable the programs are in map editing. The 

question is whether or not these three programs are useful in the same way and what the pros and cons 

to using the different programs are when producing maps. Can they produce an identical map and set of 

maps (atlas) with the exact same layout and appearance? 

There are not many reviews done on this subject. At most a forum can be found where people are 

discussing the differences or an online article who points out the differences. This reading is of course 

interesting and gives a good start to understanding what program to use. However, if a more profound 

research is required on the pros and cons with the programs and their functionality there is not much 

scientific work to be found. What can be found is information about the importance of maps and what 

role they have played in history. Also, information can be found about the different parts of a map as 

well as what programs that can be used and the functionality of these. 

1.2 Objectives 
The objective of this research is to examine the possible differences in producing maps in the three 

programs QGIS, ArcGIS and MapInfo and to look at the possibility of creating the exact same map and 

map series in these three programs. The specific objectives are: 

 To explore and learn about the map production process in the programs 

 To evaluate the three programs by trying to create the same map and map series (using the 

same data, layout, symbols, labels, etc.) 

 To analyze the advantages and disadvantages of the different programs when it comes to 

producing maps 
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2 Literature review 

2.1 History of maps and GIS 
Visualization of the reality has for a long time been of huge interest for humanity and can be seen as a 

fundamental tool for helping the human mind making sense of its surrounding. One of the first known 

maps is claimed to have been produced in 6200 BC depicting the town of Konya, and the first world map 

is described in books from 550 BC. Before computers were commonly used spatial data was most often 

encountered as maps and were initially hand drawn. Already in the 16th century techniques and 

instruments for precise observation and measurement were well-developed. In the 18th century map-

makers started to show more than just geographical position – thematic mapping of geological, 

economic and medical data took root[2].  

The historical importance of the map is a widely discussed subject. Maps can be seen as one of the 

oldest forms of human communication. Ever since maps became an everyday object in civilizations there 

have been relatively few societies in the world that do not use maps[3]. As stated before, the concept of 

thematic mapping was established already in the 18th century and played an important role in analyzing 

and visualizing the society in form of a wide variety of topics – economic, social, medical etc.  

Another way of looking at the importance of the map is by looking at the role it has played in politics. In 

an article about maps, knowledge and power Harley[4] explores the discourse of maps in the context of 

political power. It is claimed that the history of the map is inextricably linked to the rise of the nation 

state in the modern world and that maps can be seen as weapons of imperialism. He also talks about 

how you choose to display a map plays a consequential role in how people interpret the world.  

It was not until the second half of the 20th century that computer software was used to analyze and 

visualize spatial data. The concept of analyzing and displaying information that can be located on the 

face of the earth is most often referred to as GIS, Geographical Information Systems. One of the first 

systems called GIS appeared in Canada in 1964. Both Heywood[5] and Coppock[6] state that the history 

of GIS is hard to summarize as there are no available GIS archives and very little critical research on the 

subject. Despite that, one can look at the development and give some background for the systems and 

concepts we use today. One of the concepts is computer cartography and refers to the storage and 

editing of maps using a computer. The primary reason for developing computer cartography was to 

speed up and improve the process of map production[5]. Computer cartography is closely linked to 

computerized GIS as it is often the last step of a GIS analysis – the way the result is presented. This 

makes knowledge of map production important and very relevant when working with different GIS 

analysis.  

2.2 Map production and visualization 
The practice of making maps is often referred to as cartography. Friendly[2] state that the goal of 

cartography is visual representation for exploration and discovery which ranges from the simple mapping 

of locations to spatial distributions of geographic characteristics. Maps help their users to understand 

geospatial relationships and information such as distances, directions and area sizes can be showed. It is 
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stated that there exists four different fields of visualization; exploration, analysis, synthesizing and 

presentation[15]. Presentation is the key focus of this study. 

The most common method to visualize information in GIS is by creating a map. This can be referred to as 

map production which includes several steps. Some steps of map production could be editing, 

generalization, interpolation, quality management and harmonization. An enormous number of different 

types of maps can be produced by a variety of methods[16]. To create a map you need a great deal of 

understanding in the complex process of map production. Unfortunately there is not a lot of literature 

on producing quality output maps with GIS. As stated before the role of the map is to communicate 

spatial information and this information includes location, size, shape, pattern, distribution and trends in 

spatial objects. How to display this information is a choice of the producer and can be manipulated to 

suit the purpose. It is important to remember that these choices come with responsibility and that it 

determines how effective the map will be as a communication tool[5].  

 

Figure 1. Map components[5]. 

2.2.1 Parts of the map 

A number of graphic and nongraphic elements are used to help the user to get an idea of how the map 

relates to the real world. These elements are shown in Figure 1 and are explained below: 

Reference grid, scale and north arrow 

The grid contains lines covering the map representing latitude and longitude or planar coordinates. The 

grid helps give a spatial frame of reference and provides information on scale and orientation. It can also 

be used to divide a map into smaller parts when creating an atlas. 
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 A north arrow may be a good complement or substitute for the grid but is often used as a standard 

component even if you have a grid. In addition to the grid a numerical or graphical scale can be added to 

provide information about the size of features and distance between features on the map.  

Legend and symbolism 

A legend is used to explain the symbols used on the map to represent different features. The symbols 

could be points, lines or polygons and can all differ in size, shape and color. To make it easier for the user 

to relate the map to the real world it is often important to match the symbols to the reality. It is for a 

good reason that an area representing a forest is colored green.  

Intelligent orientation figures 

An intelligent orientation figure, also called inset map, is used to show the location of the map within its 

wider geographical setting and is very useful to show an approximate geographical location. The 

orientation figure can also be useful when creating series of maps to display which part of the “big” map 

you are looking at.   

Dynamic text 

Dynamic text is text placed on a map layout that changes dynamically based on the current properties of 

the map. This means that when a property is updated, the dynamic text will automatically update. 

Examples of this text could be page number, current page name, date for last saved etc. 

2.3 Programs to use 
When looking at available desktop programs for GIS analysis and map production the first thing to do is 

to divide them into two types – proprietary GIS software and open source GIS software. The first one 

represents programs where one have to pay for a license to be able to use the software. Many teachers 

choose proprietary GIS software for GIS education because students will learn the mainstream software 

skills and therefore have advantages in the job market[7]. The most common proprietary GIS program is 

ArcGIS, a product delivered by Esri, which include several software programs for GIS analysis. Other 

examples of common proprietary GIS programs are MapInfo, GeoMedia, GeoBas, DP/Map and Global 

Mapper. 

The other type – open source GIS software – is free software that can be accessed, used or modified by 

the user. This means that the program can be downloaded for free and then the users can utilize it the 

way they want. In contrast to proprietary GIS software open source software are published along with 

their respective source code which enables modification[8]. A drawback is stated by Tsou[7]; “one 

common problem in open source desktop GIS software is the lack of advanced cartographic functions 

and symbolization”. One of the oldest open source GIS software is GRASS (Geographical Resources 

Analysis Support System) which was developed from 1982 to 1995 and is still used today. Nowadays 

there are several open source GIS software products on the market. Examples of these programs are 

QGIS, OpenJump and uDig. 
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The focus and evaluation of this study will solely be on ArcGIS, QGIS and MapInfo. These programs are 

frequently used by Sweco and since this project is carried out together with Sweco, the study is set after 

their requirements and their interest in how interchangeable the programs are in map editing.   

2.3.1 ArcGIS 

ArcGIS is a GIS software delivered by Esri. As stated before, it is one of the most commonly used GIS 

programs both by companies and in education. It was initially released in 1999 and has developed ever 

since. ArcGIS for desktop includes several desktop software and are available at three functionality 

levels.  

ArcMap is the central application used in ArcGIS and provides the user with many features. On Esri’s 

homepage you can read about the key features of ArcGIS. They state that producing high-quality maps is 

made easy and the user can take advantages of a large library of symbols[9].  

2.3.2 QGIS 

Quantum GIS, or QGIS as it is called today, is an open source GIS founded by Gary Sherman in 2002. 

While looking for a fast geographic data viewer he found that most commercial GIS software was 

licensed and that they only worked for one operating system. For that reason he started to develop a 

new and free software – QGIS. Today QGIS is used by thousands of people all around the world[10] and 

is increasingly becoming a viable alternative to proprietary desktop GIS software. QGIS can be 

downloaded for free and runs on most operating systems. 

QGIS offers a wide range of functions and features resembling the functionality of ArcGIS. When editing 

maps QGIS provides the user with several functions. This includes, for example, digitizing of vector 

features, the possibility to add and remove points, lines and polygons from the existing data and various 

symbol choices[11]. 

2.3.3 MapInfo 

MapInfo Professional is a desktop GIS software product provided by Pitney Bowes. The software was 

founded in 1986 by four students who wanted to develop an inexpensive mapping tool for PC. Later on 

the software was sold to Pitney Bowes and the first desktop GIS, MapInfo Professional, was developed in 

1986. 

In the latest version MapInfo Professional 12.0, there have been improvements in creating high quality 

cartographic output. According to MapInfo’s website the improvements includes output features as 

labelling, scale bars and many more[12].  

3 Data 

3.1 Raster data 
Raster data contains of rows and columns of cells where each cell is represented by a value. The most 

common form of raster data is images where the cells, or pixels, contain color values. The cells can also 

represent values for heights, type of vegetation etc.  
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3.1.1 WMS background map 

A WMS, Web Map Service, is a service that provides geo-referenced map images dynamically over the 

internet and is generated by a map server using data from a GIS database. The maps are usually 

delivered in a pictorial format such as PGN, GIF or JPEG but are in some cases available as vector-based 

graphical elements. The advantage of using a WMS map as a background is that it is continuously 

updated and therefore the background map will never be out-of-date. 

In this project the WMS map is provided by Stockholms stad through their site Open Stockholm where 

open geographic data can be acquired over the Stockholm region[13]. In this project the grey simplified 

and muted WMS-map will be used. This map shows Stockholm with a grey color which will make it easier 

to display the points, lines and polygons that will be used and are explained below.    

3.2 Vector data 
 Vector data structure is used to represent points, lines and polygons. Vector data is a commonly used to 

represent different features and the simplest structure is defined by coordinate geometry.  

3.2.1 Points 

The features that will represent points are castles, manors, churches and hospitals in the Stockholm 

region. This data can be downloaded from the Swedish authority of surveying – Lantmäteriet. 

Lantmäteriet usually do not supply data free of charge, however, they offer their digital maps for free to 

students and employees that are registered at a university. This service is provided through SLU (Sveriges 

lantbruksuniversitet) with the web tool GET (Geographic Extraction Tool). GET provides both vector and 

raster data over Sweden. In this project the features needed are all found in the road map (Vägkartan) 

which contains several shape-files with data such as roads and settlements. 

3.2.2 Lines 

The line features will also be provided from the web tool GET through the road map. The line features 

will solely be represented by the municipal boarders in Stockholm. As the road network is displayed in 

the WMS map over Stockholm there will be no lines representing roads. 

3.2.3 Polygons 

Last but not least there has to be data that represent polygons. In this project this data will be 

represented by the existing wildlife preserves in Stockholm. This data is provided by Naturvårdsverket 

and can be downloaded online through Länsstyrelsen at their site for national geo-data[14].    

Table 1. Data used in the study. 

Data name Data type Format Publisher Coordinate system 

WMS-map Raster Png, jpg Stockholms stad SWEREF 99 18 00 

Vägkartan Vector Shape Lantmäteriet SWEREF 99 TM 

Naturreservat Vector Shape Naturvårdsverket SWEREF 99 TM 
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4 Method 

4.1 Preprocessing 
To make the evaluation as comparable as possible the project is performed as an experiment. This 

means that the same input will be used and the goal is to produce the same map and series of maps in all 

of the chosen programs. Since the data is not delivered in the same coordinate system preprocessing has 

to be performed on the data to get the same input. It is decided that the map will cover the area of 

Stockholm and therefore the coordinate system that will be used is SWEREF 99 18 00. This will be done 

by using the geographical information system utility Feature Manipulation Engine, further referred to as 

FME. FME has a collection of tools for transformation and translation of data. 

All three programs can handle shape-file format and therefore there is no need for manipulation of the 

delivered formats. 

4.1.1 Raster data 

The WMS-map over Stockholm is published in three coordinate systems; SWEREF 99 18 00, SWEREF 99 

TM and WGS 84. When opening the map in the programs one simply have to choose the required 

coordinate system.  

4.1.2 Vector data – Points and lines 

The vector data downloaded from Lantmäteriet is delivered as several shape-files. First of all the 

coordinate system had to be changed from SWEREF99 TM to SWEREF 99 18 00. This was done by using 

the Reprojector tool in FME which simply takes the input data and re-projects it into the wanted 

projection (Figure 2).  

 

Figure 2. Screenshot of FME Reprojector tool. 
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Not all of the delivered data is of interest to this study which means the relevant data had to be 

extracted from the original data delivered. To do this the data was opened in ArcMap and a selection of 

data was exported into new shape-files. 

4.1.3 Vector data – Polygons 

The data containing polygons over the wildlife preserves covers the whole of Sweden. To only get the 

data over Stockholm a restriction had to be made. The first step was to mark the required region in 

ArcMap and saving it as a shape-file (Figure 3). 

 

Figure 3. The required area marked in ArcMap. 

The next step was to open the wildlife preserves file and the shape-file with the restriction in FME and 

use the Clipper tool. The data containing the polygons over the wildlife preserves was delivered in 

SWEREF99 TM and therefore it had to be re-projected into SWEREF 99 18 00 before putting it into the 

clipper tool (Figure 4).  

 

Figure 4. Screenshot of FME Clipper tool. 
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4.2 Designing the layout 
As described in section 4.1, the required data was acquired and manipulated to fit the project. When this 

was accomplished the next step was to decide the layout 

for the individual maps.  

The following features were chosen for the layout: 

 A4 (portrait) 

 Title above map 

 Map in upper part of the page 

 North arrow on bottom left of map 

 Orientation figure on bottom right 

 Legend bottom left 

 Logotype (Sweco) above legend 

 Scale bar on bottom right of map 

 Scale above orientation figure 

 License information below legend 

 Information about the coordinate system above 

logotype 

 Grid dividing the map into smaller divisions 

 

 

Further on the symbology for the points, lines and polygons will be decided. 

4.3 Importing the data and setting the symbols 
To start, the acquired data was added in the programs and the WMS background map was inserted. The 

next step was to change the symbols to the required appearance.  

4.3.1 ArcGIS 

When the data was imported the first thing to do was to make sure that the layer containing points 

representing buildings get unique values. This was done in Layer properties by choosing unique values 

under the tab Symbology (Figure 6).  By completing this, the symbol for each class can be determined. To 

change the appearance of the line and polygon features the same procedure was performed.  

Figure 5. Example layout. 



DEGREE PROJECT IN BUILT ENVIRONMENT, FIRST CYCLE 
ANNA ÖSTERMAN 

 

10 
 

 

Figure 6. Changing the symbol style in ArcMap. 

4.3.2 QGIS 

In QGIS, the tab Style in the Layer properties was used to get unique values for each building. By 

choosing Categorized the values can then be classified by defining a column (Figure 7). To choose 

alternative symbols, click on the symbols to access the Symbol properties. The lines and polygons were 

changed in the same way. 

 

Figure 7. Changing the symbol style in QGIS. 
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4.3.3 MapInfo 

In MapInfo there was no direct access to the unique values under Layer properties. To access the unique 

values for the buildings a thematic map has to be created. This was found under Map > Create a 

thematic map where several types and templates can be chosen to create the thematic map.  When the 

thematic map was created symbols can be chosen from a range of styles (Figure 8).  

 

Figure 8. Changing the symbol style in MapInfo. 

 

4.4 Creating a simple map 
When the style and color of all the displayed features have been decided a layout is created for 

presenting the map. In this project a pre-established layout was used and is explained in section 0. 

4.4.1 ArcGIS 

To create a layout in ArcGIS the view has to be changed to Layout view. At first the view only consists of 

a blank paper showing the map as it was displayed in the data view. In the layout view the map extent 

can be defined as well as adding additional components such as legend, scale bar, title etc. The map 

components were all found under the tab Insert (Figure 9). 
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Figure 9. Layout view in ArcMap. 

4.4.2 QGIS 

Creating a map layout in QGIS was done in the Composer manager. This is where the desired 

components are added, as well as deciding their appearance (size, placement, etc).  

 

Figure 10. Composer manager in QGIS. 

4.4.3 MapInfo 

The simplest way to create a map in MapInfo is to use the New layout window which is accessed from 

several menus. In the layout window the map components can be added by drawing a frame for their 

position and then choosing what window to open. This means that the components have to be created 

before opening the layout window for them to be available. 
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Figure 11. Layout window in MapInfo. 

4.5 Creating an atlas 
Before an atlas can be created a division of the full map has to exist. In this study a grid was generated. 

The grid will cover the map and divide the area into smaller parts. To match the background map over 

Stockholm as well as possible the scale of the individual squares was set to 1:30 000 and the total 

number of squares to 25. 

4.5.1 ArcGIS 

To create a grid in ArcMap the Grid Index Features tool was used (Figure 12). This tool has several 

designing options to size the grid as desired.  

 

Figure 12. Grid Index Features tool in ArcMap. 
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An atlas was created by using Data driven pages in ArcMap (Figure 13). The data driven pages generates 

multiple output pages from a single layout by using an index layer – in this case the grid which was 

created in the previous step. 

 

Figure 13. Set up for Data Driven Pages in ArcMap. 

When an atlas is generated there is a choice of creating an inset map. To create an inset map a copy of 

the grid has to be made and then page definition has to be enabled. This was found via Layer Properties 

> Definition Query > Page Definition. 

4.5.2 QGIS 

In QGIS the grid was created via Vector > Research Tools > Vector grid. In this tool the extent of the grid is 

decided by choosing a layer and then updating the coordinates from it (Figure 14). 

 

Figure 14. How to create a grid in QGIS. 



DEGREE PROJECT IN BUILT ENVIRONMENT, FIRST CYCLE 
ANNA ÖSTERMAN 

 

15 
 

The atlas was generated in the Composer manager. An atlas was created by marking the Generate an 

atlas box and choosing what layer to generate it from.  The next step was to check the box Controlled by 

atlas under the map’s properties.  

 

Figure 15. How to generate an atlas in QGIS. 

To get the inset map to show the current location that is displayed the choice was found under Overview 

map (Figure 16). 

 

Figure 16. Configurations for an inset map in QGIS. 

4.5.3 MapInfo 

There was no tool for generating an atlas in MapInfo. The alternative is to create individual maps for 

each map page.  
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4.6 Exporting and printing 
To show the individual maps and the atlases in full extent and present them on a paper they were first 

exported to PDF’s and then printed. The full extent maps are found in the Appendix. 

4.7 Evaluation schema 
The evaluation schema presents the result of the study in a concrete and simple way. The idea was to 

line up the steps and functions in the map production process and then mark if they were possible in the 

individual programs or not.  

5 Result and Discussion 
The purpose of this study was to investigate the possible differences in map visualization in ArcGIS, QGIS 

and MapInfo. As seen in the literature study there was not a lot to be found regarding this subject. 

Instead, most of the preliminary investigation was made on how maps can be displayed and the 

background for the chosen programs.   

The result of this study indicates that it is possible to create the same map in all of the chosen programs, 

except for some minor differences. The differences, for example the position of the legend title, depends 

on that its position was not editable in neither ArcGIS nor QGIS. The evaluation schema shows what 

functionality the programs have, which is profitable, but the biggest difference lies in how user-friendly 

they programs are. An important thing to remember is that this is a subjective feeling and could depend 

on what programs you have worked with before. Surprisingly, I would say that ArcGIS and QGIS are 

equally user-friendly while MapInfo takes more time to get used to. Furthermore there are a lot more 

instructions to be found for ArcGIS and QGIS which helps the user proceed if they get stuck.    

Since this thesis only tested one type of map, which is pretty simple, and with one set of data it is 

important to have in mind when reading this report that one can have a totally different opinion on the 

functionality of the programs. To explore and test every single function and option is a huge task. Parts 

of the map production process such as map generalization, editing or interpolations were not included in 

this study. Therefore the result of this study should be interpreted with caution.  

5.1 Importing the data and setting the symbols 
Importing the data was not particularly difficult in any of the three programs. ArcGIS and QGIS work in 

the same way and accept shape-files with no extra complications. MapInfo, on the other hand, demands 

that you create a TAB-file before you can open the file in the program. Worth mentioning is the fact that 

it was known from before that all three programs accepted shape-files and therefore there were no 

unsuspected complications with importing the data. How the programs work with other formats is left to 

explore. In addition to this, the files were pre-processed to fit this study beforehand which made it easy 

to start directly. The pre-processing was partly made in ArcGIS which leaves the question if it would be 

possible to pre-process data in QGIS and MapInfo unanswered. At many times the data is not delivered 

exactly in the shape required and therefore it is very suitable that it is possible to manipulate the data in 

the program used. This part could have been interesting to add to the study, however, the focus was on 

the map production functionality of the programs and not on their data handling functionality.  
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When it comes to setting the symbols and the selection of symbols the evaluation indicates that ArcGIS 

is the best. ArcGIS has a range of preset symbols resembling reality and it is also easy to create custom 

symbols. The symbol selector is easily accessible by a click on the symbol which is logical and user-

friendly. The only negative thing about ArcGIS symbology functionality is that the lines and polygons are 

a bit tricky to edit, however, the choice of preset symbols mostly compensate for that. 

QGIS, like ArcGIS, has preset symbols but the selection is not very big and it seems that they look rather 

unprofessional. However, when you are a little bit more comfortable with the program it is easy to 

design your own symbols which can be added to the symbol directory. 

MapInfo differs from the other two programs and can feel a bit tricky at first, especially if you have 

gotten accustomed to ArcGIS first. There is no access to the unique values in a layer. Instead, to access 

the unique values, a new layer is created with the Create a thematic map tool. The process itself is not 

complicated but might not be obvious for a first time user. The selection of symbols in MapInfo is not 

very exciting and there is no way to create your own symbols in the program. An advantage with 

MapInfo would be that the labels are movable by hand. This is helpful when many labels have to be 

displayed in a small area and where there is a risk for conflict. In ArcGIS and QGIS you have less control 

over where the labels end up and what labels that get erased. This can be seen in the simple QGIS map 

where some labels of the wildlife preserves were not displayed and there was no way to correct this.  
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5.2 Creating a simple map 

 

Figure 17. Result output from the three programs; ArcMap (upper left), QGIS (upper right) and MapInfo (down). 
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The process of producing a simple map is a bit different in the three programs. In ArcGIS you switch to 

the layout view where a frame for the current data view is automatically displayed. In both QGIS and 

MapInfo a separate window is opened where you can work with the layout. There is no pre-defined 

frame for the map which means it has to be added separately.  

As seen in the evaluation schema (Table 2) all three programs have the necessary components of a 

layout, but there is more to discuss about this.  

The layout view in ArcGIS is easy and logical to work with. All the necessary map components are found 

under the Insert tab and when inserted they are easy to work with and easy to adapt. The program has a 

large selection of north arrows and scale bars which makes it easy to design the map after your 

requirements. One thing that can be seen both as a pro and a con with ArcGIS is the detailed choice in 

the properties of the features. At times it can be complicated and intricate. An example of this is the 

legend and scale bar which are hard to design if you are not familiar with this process. However, the 

preset alternatives are often good. 

The layout composer in QGIS is also easy and logical to work with. To add a component there is menu on 

the left side of the window where you can choose from several components. When the component is 

added to the layout you can design it with the help of the object properties. The alternatives in the 

properties are often easy to understand and the names are logical. When a property is changed it is 

immediately updated in the layout which helps the user to get an idea of what can be changed and not. 

A function that was appreciated was the snapping tools. These helped with placing components in the 

middle and in line with other objects. One drawback is the choice of north arrows. There is only one 

alternative which works but feels a bit to plain. The option would be to import a SVG image.  

MapInfo is different in comparison to the other programs when it comes to working with the layout. It 

takes time to get used to the work procedure and at the beginning it feels like nothing is possible. When 

a new layout window is opened you have the choice of adding a frame for every existing window. These 

are then displayed in the layout in what seems to be random positions. There is no obvious way to add 

new components such as legend, scale bar and north arrow. For example, to add a legend or an external 

image (in this project the logotype) a new window has to be created and it is firstly then it can be added 

as a new frame.  In ArcGIS and QGIS these are created in the layout window. 

Another thing that lowers the user-friendliness is the fact that there is no direct link to the components 

properties which makes it difficult to change them. It took time to realize that it actually were possible to 

edit a frame’s thickness, for example. Furthermore, most of the components are added with an external 

tool through MapBasic, which is the programming language for MapInfo. This was time-consuming and 

complicated and offered very little design possibilities. 
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5.3 Creating an atlas 

 

• • • 

 

Figure 18. ArcMap atlas. 
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• • • 

 

Figure 19. QGIS atlas. 
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The task of creating an atlas solely focused on the possibility of generating an atlas. This refers to 

producing individual map pages from given settings. For this to be possible a grid had to be made. This 

process worked more or less the same way in both ArcGIS and QGIS. First a layer had to be defined to 

know what area the grid would cover. Then the size of the individual squares which would define the 

extent of the map pages was decided. One interesting point to note was that the size of the individual 

squares in both programs was set to the scale 1:30000 but the result turned out differently. This can be 

seen in the first five pages of the atlas where ArcGIS has left a small stripe above the map blank. A 

function for creating a grid was found in MapInfo, through MapBasic, however, it did not work as 

expected and therefore I decided to not move forward with it. 

As seen in the methodology and in the results only ArcGIS and QGIS were able to generate an atlas. The 

atlas generation was relatively simple in both programs. The process in ArcGIS did not feel as straight 

forward as the process in QGIS. In QGIS the settings are directly accessible in the layout composer while 

in ArcGIS the Data Driven Pages is a separate tool. Adding to this the configurations is easier to 

understand in QGIS.  

A complement to the atlas was the inset map and to make sure that the region showed was marked on 

the inset map. This was definitely easier in QGIS where the configuration was accessible through the map 

configuration. In ArcGIS this was done by copying the existing grid and enabling Page Definition which 

was little bit more complicated.    
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5.4 Evaluation schema 
Table 2. Evaluation schema of map production functionallity. 

 ArcGIS QGIS MapInfo 

Symbols    

-Preset symbols √ √ √ 

-Design own symbols √ √ — 

-Good color choice √ √ √ 

-Thematic mapping √ √ √ 

Labels    

-Placement choice √ √ √ 

-Moving by hand — — √ 

-Conflict detection √ — √ 
Layout    

-Legend √ √ √ 

Choice of content √ √ √ 

Placement options √ √ — 

Free placement  of 
content 

— — √ 

-North arrow √ √ √ 

        Multiple choice √ — √ 
-Own image (logotype) √ √ √ 

-Scale bar √ √ √ 

        Multiple choice √ √ — 
-Grid √ √ — 

-Snapping tools — √ — 

Atlas    

-Generating atlas √ √ — 

-Inset map √ √ — 

-Dynamic text √ √ — 
Map Editing Not tested Not tested Not tested 
Generalization Not tested Not tested Not tested 
Interpolation Not tested Not tested Not tested 
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6 Conclusion 
This thesis has examined the possible differences in map visualization in the three programs ArcGIS, QGIS 

and MapInfo. The starting point was to have the same set of data and then to try to create an identical 

map in all three programs and from the process and result evaluate the pros and cons with the 

programs.  

The study shows that the functionality of map editing in the three programs ArcGIS, QGIS and MapInfo is 

more or less the same, which becomes quite clear when looking at the evaluation schema. The biggest 

difference is that MapInfo does not offer the option of generating an atlas which affects its final grade 

negatively. MapInfo is also the program which was the hardest to work with and become familiar with. 

ArcGIS and QGIS on the other hand were more user-friendly and their overall functionality was better 

and easier to work with. The fact that QGIS is free software makes it stand out more and makes it a real 

contestant to ArcGIS while MapInfo feels like a paler version of ArcGIS.  

Hopefully, the result and evaluation of this study will give a better understanding of what program to use 

and when to use it. In the end, the choice is the users and can at many times be dependent on their 

background and on what they have worked with before. Therefore it is important to remember that this 

study is my own subjective perspective based on my background.  Another thing that is important to 

have in mind is that this study only tested one type of map. Therefore the evaluation is limited to the 

functions and challenges that were encountered from this study. Also, some of the obstacles that I came 

across might have been resolvable for someone more familiar with that particular program.  

For a more in-depth investigation, more time could be spent on different types of maps to test more 

functions. It would also be interesting to evaluate the differences of the rest of the programs 

functionalities since map production only is a small part of what the programs offer. 

  



DEGREE PROJECT IN BUILT ENVIRONMENT, FIRST CYCLE 
ANNA ÖSTERMAN 

 

25 
 

References 
 

1. Korte T. The Coming Wave of Innovation from Open Geographic Information: SmartData 
Collective; 2014 [cited 2014 Feb 26]. Available from: 
http://smartdatacollective.com/tkorte/187511/coming-wave-innovation-open-geographic-
information. 
2. Friendly M, Denis DJ. Milestones in the history of thematic cartography, statistical graphics, 
and data visualization. Seeing Science: Today American Association for the Advancement of Science. 
2008. 
3. Harley JB, Woodward D. The history of cartography. Chicago: The university of Chicago 
press; 1987. 
4. Harley JB. Maps, knowledge, and power. Geographic thought: a praxis perspective. 
2009:129-48. 
5. Heywood I, Cornelius S, Carver S. An introduction to Geograpical Information Systems. Third 
ed. Edinburgh Gate: Pearson Education Limited; 2006. 
6. Coppock JT, Rhind DW. The history of GIS. Geographical information systems: Principles and 
applications. 1991;1(1):21-43. 
7. Tsou M-H, Smith J. Free and Open Source software for GIS education2011. Available from: 
http://www.iapad.org/publications/ppgis/tsou_free-GIS-for-educators-whitepaper.pdf. 
8. Warf B. Open Source GIS.  Encyclopedia of Geography. Thousand Oaks, CA: SAGE 
Publications, Inc.; 2010. 
9. Esri. ArcGIS for Desktop - Key Features  [cited 2014 April 9]. Available from: 
http://www.esri.com/software/arcgis/arcgis-for-desktop/features. 
10. Hugentobler M. Quantum GIS.  Encyclopedia of GIS: Springer; 2008. p. 935-9. 
11. QGIS. Available from: http://www.qgis.org/en/site/about/index.html. 
12. MapInfo Professional. Available from: http://www.mapinfo.com/product/mapinfo-
professional/. 
13. Open Stockholm. Available from: http://open.stockholm.se/oppna-data/geodata/. 
14. Länsstyrelsen. Nationella geodata. Available from: 
http://projektwebbar.lansstyrelsen.se/gis/Sv/Pages/nationella-geodata.aspx. 
15. KRAAK, Menno-Jan; ORMELING, Ferjan. Cartography: visualization of spatial data. Guilford 
Press, 2011. 
16. Map production. International Cartographic Association. Avalible from: 
http://icaci.org/research-agenda/map-production/ 
 

 

  

http://smartdatacollective.com/tkorte/187511/coming-wave-innovation-open-geographic-information
http://smartdatacollective.com/tkorte/187511/coming-wave-innovation-open-geographic-information
http://www.iapad.org/publications/ppgis/tsou_free-GIS-for-educators-whitepaper.pdf
http://www.esri.com/software/arcgis/arcgis-for-desktop/features
http://www.qgis.org/en/site/about/index.html
http://www.mapinfo.com/product/mapinfo-professional/
http://www.mapinfo.com/product/mapinfo-professional/
http://open.stockholm.se/oppna-data/geodata/
http://projektwebbar.lansstyrelsen.se/gis/Sv/Pages/nationella-geodata.aspx


DEGREE PROJECT IN BUILT ENVIRONMENT, FIRST CYCLE 
ANNA ÖSTERMAN 

 

26 
 

Appendix 
 

Simple map– ArcGIS    pg.1 

Simple map – QGIS     pg.2 

Simple map – MapInfo    pg.3 

Atlas – ArcGIS     pg.4-6 

Atlas – QGIS      pg.7-9 
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